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When investing in a server for your business’s remote office, you’re looking for

one that can deliver excellent performance for everyday applications and has plenty of

room to grow as your business grows. The Dell PowerEdge R720 server with Samsung

SM825 200GB solid-state drives, or SSDs, and Windows Server 2012 meets both criteria.
In our tests in the PT labs, this Dell and Samsung solution running Windows

Server 2012 comfortably supported workloads of 250 and 500 users simultaneously

running Microsoft SharePoint 2010 and SQL Server 2012 on one Dell PowerEdge R720
server, and Exchange Server 2010 on a second Dell PowerEdge R720 server.

Even with a 500-user workload, the solution completed Microsoft SharePoint

and Exchange tasks with response times well below acceptable thresholds, and easily
delivered 2,899 database orders per minute.

Being able to support 500 users with ease means the Dell and Samsung SSD
solution running Windows Server 2012 has ample hardware resources to handle

additional business applications as your productivity needs grow.
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SUPPORT YOUR CURRENT—AND FUTURE—USERS

WHAT WE FOUND

The Dell PowerEdge R720 server with Samsung SM825 200GB SSDs running
Windows Server 2012 can comfortably support 500 remote office users performing
typical business applications. We configured a setup with two servers hosting virtual
machines running the Microsoft® SQL Server® 2012 database application, Microsoft
Exchange Server 2010 for email, and Microsoft SharePoint® Server 2010 for
collaboration.

We tested this configuration by simulating first 250 and then 500 users
simultaneously accessing the database, using email, and using SharePoint. Not only
could the servers run these workloads, they did so with great performance and plenty of
resources to spare for future growth.

In our testing at both user counts, all of the latencies for our benchmarks were
well below their acceptable thresholds, showing that a Dell PowerEdge R720 with
Samsung SSDs and Windows Server 2012 delivers in performance. Specifically, the
Exchange read latency was less than 1 millisecond (ms) at both 250 and 500 users, one-
twentieth of the 20ms threshold for acceptable performance. The SharePoint latency
was less than 0.2 seconds, one-fifth of the 1-second threshold. Furthermore, we
achieved these low latencies with the SSDs configured in a RAID 5 to deliver the added
benefits of fault tolerance and maximum capacity.

The fact that the Dell-Samsung SSD-Windows Server 2012 solution can deliver
such low latencies with 500 users means that your business could add users and/or
business applications and continue to enjoy excellent performance as you grow.

We set up three VMs across our two Dell PowerEdge R720 host servers to house
the applications—the mail application ran on one server and the database and
collaboration applications ran on the other. Our goal was to run workloads simulating
our two user counts users in each VM to verify the configuration could handle the
desired user load.

Figure 1 shows the Exchange Information Store read and write latency during
the LoadGen workload for the two user counts. In all cases, the Exchange Server VM
delivered latencies well within the acceptable parameters—a read latency less than 20
milliseconds and a write latency less than the read latency. The added users in each case
show only a small increase in latency, meaning that even as your business grows, users

spend less time waiting for the email server to respond.
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Figure 1: Exchange latency
during the LoadGen workload
for the two user counts. Lower
numbers are better.

Figure 2: SQL Server
performance for the two user
counts. Higher numbers are
better.
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Figure 2 shows the SQL Server performance for the two user counts. The SQL
Server VM achieved the orders per minute (OPM) to demonstrate supporting the
respective user count. Assuming that each user is generating approximately six OPM,
250 users would mean 1,500 OPM as the theoretical maximum and 500 users would
mean 3,000 OPM as the theoretical maximum. We calculate acceptable performance as
being 90 percent of the theoretical maximum, which is 1,350 OPM in the 250-user
scenario, and 2,700 OPM in the 500-user scenario. As Figure 2 shows, the SQL Server
VM easily achieved the required OPM to support the set user count for each
configuration, obtaining 1,472 OPM with 250 users and 2,899 OPM with 500 users.

SQL Server 2012 database performance (Server #2)
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Figure 3 shows the SharePoint Server performance for the two user counts. We
assumed that each user would generate approximately one task per minute and
determined acceptable performance to be within 90 percent of the theoretical
maximum. This means that 250 users would need to generate 225 tasks per minute and
500 users would need to generate 450 tasks per minute. The SharePoint VM performed
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more than the required number of tasks per minute for each configuration. Additionally,

the average latency in each case was well below the 1-second threshold, at 0.14 seconds

with 250 users and 0.15 seconds with 500 users.
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Figure 3: SharePoint
performance in tasks per
minute during the WSSDW
workload for the two user
counts. Higher numbers are
better.
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Figures 4 and 5 show power utilization for the servers running the three

applications at two user counts. While the power usage of many servers increases

dramatically as the workload increases, our tests show only a small increase in the Dell-

Samsung SSD-Windows Server 2012 solution’s power utilization compared to its idle

state. For example, with 500 users, the Exchange workload represents a less than 10-

Watt increase in power utilization on one R720, and the simultaneous SQL and

SharePoint user workloads account for an increase of only approximately 20 Watts. This

means that even under an active workload, the power efficiency of the Dell PowerEdge

R720 with Samsung SSDs and Windows Server 2012 could potentially save you in power

and cooling costs.
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Exchange Server (Server #1) SQL Server and SharePoint (Server #2)

250 users 500 users 250 users 500 users
Idle power (W) 229.55 231.95 129.01 129.51
Active power (W) 237.7 239.26 144.32 149.41

Figure 5: Power utilization for the Dell PowerEdge R720 host servers.

WHAT WE TESTED

Database testing

We used two Dell PowerEdge R720 servers with Samsung SM825 200GB SSDs
running Windows Server 2012. We used Hyper-V to create three VMs to run the
business applications. One Dell PowerEdge R720 ran a collaboration VM running
Microsoft SharePoint Server 2010 SP1 on Windows Server 2008 R2 SP1 and a database
VM running Microsoft SQL Server 2012 on Windows Server 2012, and the other Dell
PowerEdge R720 ran a mail server VM running Microsoft Exchange Server 2010 SP2 on
Windows Server 2008 R2 SP1. To demonstrate that each VM could handle the required
users, we ran benchmarks against each VM simulating 250 and 500 users accessing data
on each. We staggered the benchmarks, allowing LoadGen to start first and warm up for
15 minutes, then starting WSSDW and allowing it to warm up for 5 minutes, then
starting DVD Store and allowing for an additional 10 minutes of warm-up time for all
three benchmarks before taking performance measurements. We measured the
performance of the three virtual machines over a 30-minute period of our test runs, and
report the median of three runs for each configuration. We based the median run on
the median Exchange read latency for each configuration.

For step-by-step instructions on how we tested, see Appendix B.

We used the DVD Store Version 2 (DS2) benchmark to simulate 250 and 500
database users. DS2 is an open-source application that models an online DVD Store
where customers log in, browse movies, and purchase movies. DS2 reports its results in
orders per minute that the server can handle.

We ran DS2 with a 40GB database and think times of 1.2 and 0.6 seconds for the
250- and 500-user scenarios respectively, so that each of our 30 threads represented
250 or 500 users completing one order approximately every 10 seconds against the SQL
Server 2012 VM. The benchmark then uses a default value of three searches on average
before each order. We define a minimum acceptable score as 1,350 OPM for 250 users
and 2,700 OPM for 500 users. We allowed for a 10-minute warm-up period, and then
set the measurement period to 30 minutes.

For more details about the DS2 tool, see

http://www.delltechcenter.com/page/DVD+Store.
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Mail testing

Collaboration testing

To test the configuration’s mail server performance, we used the Microsoft Load
Generator 2010 (LoadGen) benchmark, which performs tasks to simulate a standard
user generating mail activity. We simulated 250 and 500 users and used the following
settings:

e Mailbox Profile: 250MB mailboxes

e Action Profile: Outlook 500

e Client Type: Outlook 2007 Cached
LoadGen simulates the mail activity for the designated user count. We set the
benchmark to run for 1 hour and 15 minutes: 15 minutes for LoadGen to warm-up, then
15 minutes for the remaining benchmarks to start and warm up, 30 minutes of
measured performance time, and 15 minutes as a cool-down period to complete the
run.

For more details about LoadGen, see
http://www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-4D66-
A82F-8D3062C6FA98&displaylang=en.

To simulate the traffic of 250 and 500 SharePoint Server 2010 users, we used a
customized version of the WSSDW 1.0.0.0 Beta test. This test creates sample data,
populates the server with it, and simulates SharePoint Server users completing everyday
tasks.

We used Visual Studio 2010 to execute the test workload, generating a realistic
user workload where each of the simulated users performed a task approximately every
minute. To do this, we set up the test to run 125 virtual users with a 30-second think
time to simulate 250 users, or with a 15-second think time to simulate 500 users. We
determined acceptable performance if the latency in each case was under 1 second and
the average number of tasks per minute was within 90 percent of the theoretical
maximum.

For more details about SharePoint Server, see http://office.microsoft.com/en-

us/sharepoint-server-help/.
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ABOUT THE COMPONENTS OF OUR SOLUTION

Dell PowerEdge R720

The new Intel® Xeon® processor E5-2680-powered Dell PowerEdge R720 2U

rack server incorporates many enhancements and features designed to improve

performance, lower power consumption, and ease maintenance. Some of these

features include the following:

Performance. Dell engineered the PowerEdge R720 to handle complex
workloads, with 1/0 and internal data management technologies (i.e., NSC,
NPAR, CacheCade) to allow faster access to information and GPU
accelerators for faster than ever computational performance.

Processors. The Dell PowerEdge R720 is powered by two Intel Xeon
processors E5-2680, which incorporate the very latest in technology from
Intel. The powerful processors provide exceptional performance and make
the PowerEdge R720 a solid virtualization platform.

Power efficiency. Dell PowerEdge R720 servers implement leading industry
power efficiency standards, and are designed to optimize performance
while maintaining low power consumption. Automated tracking and
regulation of thermal activity, intelligent design of right-sized power
options, and high efficiency fans and airflow management work to save
power, saving you money in the process.

Management. The Dell PowerEdge R720, like all late-model Dell servers,
comes with the Dell Lifecycle Controller. This tool simplifies server
management by providing a single interface for management functions and
by storing critical system information in the system itself. There are no CDs
or USB keys to keep track of for drivers or firmware.

Storage. With impressive storage capacity for small business servers, the
Dell PowerEdge R720 is available in both an 8-bay and 16-bay chassis.
Memory. The Dell PowerEdge R720 holds up to 768 GB of RAM, many times
the memory capacity of older small business servers, allowing for powerful

flexibility with virtualized database solutions.

Samsung SM825 200GB SATA SSDs

According to the Dell Web site, the addition of Samsung SM825 200GB SSDs

lets the Dell PowerEdge servers deliver outstanding sustained read, write and

sequential speeds. Compared to 15K SAS hard disk drives, Samsung's E-MLC

SSDs deliver 57 times more operations per second.

The Samsung SSDs also deliver an increased level of performance and

reliability with their power-loss protection. Samsung's E-MLC SSDs increase
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write endurance by more than 100 times than that of standard MLC SSDs. That

translates into long-lasting, sustained performance for your servers.

Dell PowerEdge servers with Samsung SSDs also provide the ability to scale

for capacities from 100 GB to 400 GB and ensure that all sensitive data is secure.

They help protect your data with AES 256-bit encryption, delivering the optimal

level of security.

About Microsoft Windows Server 2012

Windows Server 2012, the latest release of this server OS from Microsoft,

includes many new features and enhancements. According to Microsoft, Windows

Server 2012 focuses on four core areas:

Beyond virtualization. Windows Server 2012 provides a robust and dynamic
virtualization platform through Hyper-V, and includes new features that
provide flexible options for delivering cloud services.

The power of many servers, the simplicity of one. Windows Server 2012
offers improvements in its features that allow for better-than-ever high
availability and ease of management for multiple-server infrastructures.
Every app, any cloud. Windows Server 2012 delivers a scalable and flexible
Web and application platform by providing a consistent and open set of
tools and frameworks that apply to applications on-premises, in the cloud,
or in a hybrid environment.

Modern work style, enabled. Microsoft Windows Server 2012 empowers
users and IT staff with remote access to data, applications, and simpler

management tools while strengthening security and compliance.

WHAT THIS MEANS FOR YOU

When you invest in a server solution for your remote office, it's important to

select one that can meet your current needs well and continue to meet your needs as

your company grows. In our testing, the Dell PowerEdge R720 server with Samsung
SM825 200GB SATA solid-state drives running Windows Server 2012 comfortably
handled 250 and 500 users, delivering solid database, collaboration, and email

performance with hardware resources to spare. This makes the Dell-Samsung SSD-

Windows Server 2012 solution an excellent choice now and for the future.
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APPENDIX A — SERVER CONFIGURATION INFORMATION

Figure 7 provides detailed configuration information for the servers in our configuration.

System Dell PowerEdge R720 Dell PowerEdge R720
(Exchange) (SQL Server/SharePoint)

General

Number of processor packages 2 2

Number of cores per processor 8 8

Number of hardware threads per core | 2 2

CPU

Vendor Intel Intel

Name Xeon Xeon

Model number E5-2680 E5-2680

Stepping C1 C1

Socket type LGA2011 LGA2011

Core frequency (GHz) 2.70 2.70

Bus frequency 8.0 GT/s 8.0 GT/s

L1 cache 32 KB + 32 KB (per core) 32 KB + 32 KB (per core)

L2 cache 256 KB (per core) 256 KB (per core)

L3 cache (MB) 20 20

Platform

Vendor and model number Dell PowerEdge R720 Dell PowerEdge R720

Motherboard model number OM1GCR 061P35

BIOS name and version Dell 1.2.6 Dell 1.2.6

BIOS settings Default Default

Memory module(s)

Total RAM in system (GB) 64 64

Vendor and model number Samsung M393B1K70BH1-CH9 Hynix HMT31GR7BFR4A-H9

Type PC3-10600R PC3L-10600R

Speed (MHz) 1,333 1,333

Speed running in the system (MHz) 1,333 1,333

Tlmlng/Latency (tCL-tRCD-tRP- 9-9-9-36 9-9-9-36

tRASmin)

Size (GB) 8 8

Number of RAM module(s) 8 8

Chip organization Double-sided Double-sided

Operating system

Name Windows Server 2012 Datacenter 64- | Windows Server 2012 Datacenter 64-
bit bit

Build number 9200 9200

File system NTFS NTFS

Service Pack N/A N/A

Language English English

RAID controller

Vendor and model number | Dell PERC H710P Mini | Dell PERC H710P Mini
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System

Dell PowerEdge R720

Dell PowerEdge R720

(Exchange) (SQL Server/SharePoint)
Firmware version 21.0.2-0001 21.0.2-0001
Driver version 5.2.112.0 5.2.112.0
Cache size 1GB 1GB
Hard drive 1
Vendor and model number Dell ST9146852SS Dell 6TB2RT6W
Number of drives 2 2
Size (GB) 146 146
RPM 15K 15K
Type SAS SAS
Hard drive 2
Vendor and model number Dell MZ5EA200HMDR-000D3 Dell MZ5EA200HMDR-000D3
Number of drives 8 8
Size (GB) 200 200
RPM N/A N/A
Type SATA SSD SATA SSD
Ethernet adapter

Vendor and model number

Intel 1350 Quad Port Gigabit Network
Daughter Card

Intel 1350 Quad Port Gigabit Network
Daughter Card

Type

Integrated

Integrated

Ethernet adapter

Vendor and model number

Intel X520-DA2 Dual Port 10 Gb

Intel X520-DA2 Dual Port 10 Gb

Network Adapter Network Adapter
Type PCI-E PCI-E
Power supplies
Total number 2 2
Vendor and model number Dell DPS-750E-S1 Dell DPS-750E-S1
Wattage of each (W) 750 750
Cooling fans
Total number 6 6
Vendor and model number AVC DBTC0638B2U AVC DBTC0638B2U
Dimensions (h x w) of each 2-1/2" x 2-1/2” 2-1/2" x 2-1/2”
Volts 12 12
Amps 1.20 1.20
Optical drive

Vendor and model number

TEAC DV-28SW

TEAC DV-28SW

Figure 7: System configuration information for the test servers.
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APPENDIX B— HOW WE TESTED

Configuring the Active Directory server

Installing Microsoft Windows Server 2012 Datacenter Edition

1. Insert the installation media into the CD/DVD drive and restart the server.

2. When the option appears, press F11 to enter the Boot Manager.

3. Select SATA Optical Drive and press Enter.

4. Press any key when prompted to boot from DVD.

5. When the installation screen appears, click My language is English.

6. Leave language, time/currency format and input method as default and click Next.

7. Click Install now.

8. When the Windows Setup window appears, click No thanks when prompted to go online to install updates.

9. Select Windows Server 2012 Datacenter (Server with a GUI), and click Next.

10. Check | accept the license terms, and click Next.

11. Click Custom: Install Windows only (advanced).

12. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated
Space.

13. Select Drive 0 Unallocated Space, and click Next, at which point Windows will begin installing, and will restart

automatically after completing.
14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
15. Log in with the previously set up password.

Creating New Disks in Windows Server 2012 Datacenter Edition

1. Inthe Server Manager window, click Tools, then Computer Management.

2. Inthe left pane, click Disk Management.

3. On the unallocated disk, right-click the disk name and click Online. Right-click the disk name again and click
Initialize Disk. When the Initialize Disk window pops up, select MBR (Master Boot Record) and click OK.
After the disk initializes, right-click the shaded area and click New Simple Volume.

On the New Simple Volume Wizard that pops up, click Next.

Select a size (maximum, in our case) and click Next.

Assign a drive letter and click Next.

Select Format this volume with the following settings and leave the default settings. Click Next.

Click Finish.

e

Configuring Windows Update

1. Inthe left pane of the Server Manager window, click Local Server.

2. Inthe main frame, next to Windows Update, click Not configured.
3. Inthe Windows Update window, in the main pane, click Let me choose my settings.
4. Under Important updates, select Never check for updates (not recommended), and then click OK.
5. Inthe left pane, click Check for updates, and install all available updates.
6. Close the Windows Update window.
Remote office server performance: Dell PowerEdge R720 server with A Principled Technologies test report 11
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Configuring Windows Firewall

NoukswnN

In Server Manager, click Tools>Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.

In the Domain Profile tab, for Firewall state, click Off.

In the Private Profile tab, for Firewall state, click Off.

In the Public Profile tab, for Firewall state, click Off.

Then click OK.

Close the Windows Firewall Properties window.

Setting up Remote Desktop

In the Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.

In the System Properties window that appears, in the Remote Desktop section, select the Allow remote
connections to this computer radio button, and click OK when the warning message appears.

Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication
(recommended), and click OK.

Disabling IE Enhanced Security Configuration

1.
2.

In the Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
In the Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both
Administrators and Users, and click OK.

Installing the Active Directory Domain Services role

Before completing this step, you will need to apply an appropriate IP address for the server. In our case, we used

192.168.1.1.
1. Launch Server Manager and select Add roles and features.
2. Click Next at the Add Roles and Features Wizard.
3. Select Role-based or feature-based installation, and click Next.
4. Select the AD server from the server pool, and click Next.
5. Select Active Directory Domain Services from the list of Roles, click the Add Features button to add features that
are required by Active Directory Domain Services, and click Next.
6. Accept the defaults selected by setup at the Select Features screen, and click Next.
7. Click Next at the AD DS screen.
8. Select Restart the destination server automatically if required at the confirmation screen, and click Install.
9. Click Promote this server to a domain controller.
10. Select Add a new forest, type in the Root domain name (fqdn), and click Next. For our testing, we used test.local
11. Type in and confirm the password, and click Next.
12. Click Next at the DNS Options screen.
13. Verify the NetBIOS name, and click Next.
14. Accept the default paths, and click Next.
15. Review the options, and click Next.
16. Verify the prerequisite check passes successfully, and click Install.
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Configuring the Dell PowerEdge R720 servers

We installed Windows Server 2012 Datacenter Edition and ran all available Windows updates on each server.

Then we completed the steps below:
Configuring a NIC team with the Public-VM NICs

1. InServer Manager, click Local Server in the left pane.

2. Inthe Properties frame, next to NIC Teaming, click Disabled.

3. Inthe TEAMS section of the NIC Teaming window that pops up, click the Tasks menu, and click New Team.

4. Assign a name to the team, and check the boxes for the two appropriate 1G adapters to add them to the team.
For our testing, we named this Team1.

When finished, click OK.

Assign an appropriate IP address to the teamed NIC (for example, 192.168.1.100), and join the server to the

o u

domain.

Adding the Hyper-V role

1. InServer Manager, click Manage—>Add Roles and Features.

2. Atthe Before you begin screen, click Next.

3. At the Select installation type, leave the default selection of Role-based or feature-based installation, and click
Next.
At the Select destination server screen, leave the default selection, and click Next.
At the Select server roles screen, check the box for Hyper-V, and click Next.

4

5.

6. When the Add Roles and Features Wizard window pops up, click Add Features.

7. Click Next.

8. At the Select features screen, click Next.

9. Atthe Hyper-V screen, click Next.

10. At the Create Virtual Switches screen, leave the NICs unselected, and click Next.

11. At the Virtual Machine Migration screen, leave the checkbox unselected, and click Next.

12. At the Default Stores screen, leave the default locations, and click Next.

13. At the Confirm installation selections screen, check Restart the destination server automatically if required and
click Install.

14. When the installation completes, click Close.

Creating a virtual switch

Complete the following steps on each host server

Open Server Manager, and click Tools=>Hyper-V Manager.

In the right pane, click Virtual Switch Manager.

Leave External highlighted under type of virtual switch, and click Create Virtual Switch.

P wwNPR

Enter a name, in our case VMSwitch, and select the Microsoft Network Adapter Multiplexor Driver from the
drop-down menu under External Network to select the teamed NIC. Check the Allow management operating
system to share this network adapter, and click Apply.

5. When the warning pops up, click Yes.

6. Click OK.
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Creating a virtual machine

1. Open Server Manager and click Hyper-V on the left hand side.

Right click the local server and click Hyper-V Manager.

Click New and select Virtual Machine.

Enter a name for the VM and click Next.

Enter 8192 for the Startup Memory. Click Next.

On the Configure Networking screen select VMSwitch to use the virtual switch and click Next.

Nouvs~wN

On the Connect Virtual Hard Disk screen, select the radio button for Create a virtual hard disk. Enter a name for
the VHD and a size of 50 GB. Click Finish.

8. After the VM is created, right-click the VM and click Settings.

9. Click Processor and increase Number of virtual processors to 8.

10. Click OK.

Creating a virtual hard disk
For the SQL and Exchange server VMs, we added additional virtual hard drives for the data and log files. We created the
data virtual drives on the SSDs and the log virtual drives on the HDDs that host the guest operating system.

Open Server Manager and click Hyper-V on the left hand side.
Right click the local server and click Hyper-V Manager.

Click New and select Hard Disk.

Click Next.

Select VHDX and click Next.

Select Fixed size and click Next.

Give the hard disk a name and location and click Next.

Select Create a new blank virtual hard disk and enter a size.
Click Finish.

Installing SQL Server 2012 on VM 1 (R720 #1)
Install Windows Server 2012 with all updates, then assign an IP (192.168.1.101) and join the domain. Install an

WK N R WDNPR

instance of Microsoft SQL Server 2012 by following these steps.

1. Connect and log into the virtual machine.

2. Insert the installation DVD for SQL Server 2012 into the appropriate Hyper-V host server’s DVD drive and attach

it to the virtual machine.

3. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2012 DVD, and
double-click it.
If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
In the left pane, click Installation.
Click New SQL Server stand-alone installation or add features to an existing installation.
At the Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant

Nouwv s

warnings, click OK.
Enter your product key, and click Next.
9. Click the checkbox to accept the license terms, and click Next.
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10.
11.
12.

13.
14.

15.

16.

17.

18.

19.

20.

21.

22.

23.
24,

If no failures are displayed after the setup support files are installed, click Next.

At the Setup Role screen, choose SQL Server Feature Installation.

At the Feature Selection screen, select the features that your organization requires. We chose the following
features for this guide: Database Engine Services, Full-Text and Semantic Extractions for Search, Client Tools
Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management Tools —
Complete. Click Next.

At the Installation Rules screen, click Next after the check completes.

At the Instance configuration screen, enter the appropriate details for your configuration. For a default instance,
leave the defaults selected. For a named instance, enter a new instance name and adjust the file paths as
necessary. Click Next.

At the Disk Space Requirements screen, click Next.

At the Server Configuration screen, choose the service account, preferably an Active Directory domain account,
fill in a password if necessary, and click Next.

At the Database Engine Configuration screen, choose Mixed Mode and enter the system administrator
password. Click Add Current User.

Click the Data Directories tab, and enter the appropriate drive and folder to which you eventually deploy the
SharePoint databases.

Click Next.

At the Error reporting screen, click Next.

At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

At the Ready to Install screen, click Install.

After installation completes, click Close.

Close the installation window.

Installing Microsoft SharePoint Server 2010 SP1 on VM 2 (R720 #1)
Install Windows Server 2008 R2 SP1 with all updates, then assign an IP (192.168.1.102) and join the domain.

1. Insert the installation DVD.
2. Launch setup.exe, and click Install software prerequisites.
3. Review the list of software, and click Next.
4. Accept the EULA, and click Next.
5. When the prerequisites finish installing, click Finish.
6. On the main SharePoint installation menu, click Install SharePoint Server.
7. Enter your product license key, and click Continue.
8. Accept the EULA, and click Continue.
9. Click Server Farm.
10. Choose the Complete server type, and click Install.
11. When the installation finishes, check the box for Run the SharePoint Products Configuration Wizard now, and
click Close.
12. On the Welcome to SharePoint Products screen, click Next.
13. On the pop-up warning about services that will need to be restarted during the configuration, click Yes.
14. Choose Create a new server farm, and click Next.
15. Enter the name of your existing database instance. In our case, this is the SQL instance on the first VM.
16. Specify a username and password, and click Next.
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17. Enter a passphrase into the Passphrase and Confirm Passphrase fields, and click Next.

18. Leave the default settings on the Configure SharePoint Central Administration Web Application screen, and click
Next.

19. Verify your settings, and click Next.

20. When the wizard has completed the configuration, click Finish.

21. Click Start the wizard to start the farm configuration wizard on the Central Administration site.

22. Choose the services you wish to include in your server farm, and click Next.

23. Enter the specifications for the new site, and click OK.

24. Click Finish.

Installing Exchange Server 2010 SP2 on VM 3 (R720 #2)
Install Windows Server 2008 R2 SP1 with all updates, then assign an IP (192.168.1.103) and join the domain.

1. Select Start->Administrative Tools—>Server Manager.

Click Add Roles.

At the Before You Begin screen, click Next.

At the Select Server Roles screen, click Web Server (lIS).

If prompted by an Add features required for Web Server (IIS) pop-up window, click Add Required Features.
Click Next.

At the Web Server (11S) screen, click Next.

At the Select Role Services screen, select the Static Content, Default Document, Directory Browsing, HTTP Errors,
HTTP Redirection, ASP .NET, .NET Extensibility, ISAPI Extensions, ISAPI Filters, HTTP Logging, Request Monitor,
Tracing, Basic Authentication, Windows Authentication, Digest Authentication, Client Certificate Mapping
Authentication, Request Filtering, Static Content Compression, Dynamic Content Compression, 1S 6 Metabase
Compatibility, IIS 6 WMI Compatibility, and IIS 6 Management Console checkboxes, and click Next.

9. At the Confirm Installation Selections screen, click Install.

NV e WwN

10. At the Installation Results screen, click Close.

11. Select Start->Administrative Tools—=>Server Manager.

12. Click Features.

13. Click Add Features.

14. Select .NET Framework 3.5.1 Features.

15. When the Add Features Wizard pop-up prompts you, click Add Required Role Services.

16. Click Next.

17. Click Install.

18. At the Installation Results screen, click Close.

19. Download the Microsoft Filter Pack 2.0.
(http://www.microsoft.com/downloads/en/details.aspx?FamilylD=5cd4dcd7-d3e6-4970-875e-aba93459fbee )

20. Run FilterPack64bit.EXE.

21. Click Next.

22. Check the | accept the terms in the License Agreement box, and click Next.

23. When the installation completes, click OK.

24. Click Start->Administrative Tools—>Services.

25. Right-click the Net.TCP Port Sharing service, and click Properties.

26. Change the Net.TCP Port Sharing startup type to Automatic, and click OK.
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27.
28.
29.

30.

31.
32.
33.
34.
35.
36.
37.
38.

39.

40.
41.

42.
43,

44,

45,
46.
47.
48.

49.
50.

51.
52.
53.

Open a command prompt, type ServerManagerCmd —i RSAT-ADDS, and press Enter.

Reboot the server.

Insert the Exchange Server 2010 SP2 installation DVD, and capture the DVD drive in the VM session. When the
Autoplay window appears, click Run Setup.EXE.

The installer should consider steps 1, 2, and 3 to be complete (they appear grayed out). Click the link to Step 4:
Install Microsoft Exchange.

To go past the introduction screen, click Next.

Accept the license agreement, and click Next.

Select No for error reporting, and click Next.

Select Typical Exchange Server Installation, and click Next.

Leave the organization name at default (First Organization), and click Next.

At the question about client computers running Outlook 2003 or Entourage, select Yes, and click Next.

To accept defaults for Configure Client Access server external domain, click Next.

At the Customer Experience Improvement Program screen, select | don’t wish to join the program at this time,
and click Next.

If a warning about a lack of SMTP appears after the check finishes, ignore it for now. We address this issue in
steps 42-52 below.

Click Install to start the installation process.

After the installation has completed, click Finish. Exchange should automatically open the Exchange
Management Console.

At the pop-up that warns about rebooting, click OK.

If Exchange does not automatically open the Exchange Management Console, click Start—>All
Programs—>Microsoft Exchange Server 2010->Exchange Management Console.

In the left pane, expand Microsoft Exchange On-Premises, expand Organization Configuration, and select Hub
Transport.

In the Actions pane on the far right, select New Send Connector.

Name the send connector SMTP, select the intended use as Internet, and click Next.

In the Address space window, click Add.

In the SMTP Address Space window, type * as the address, check the Include all subdomains checkbox, and click
OK.

Click Next.

On the Network settings page, select Use domain name system (DNS) “MX” records to route mail automatically,
and click Next.

In the Source Server window, accept the defaults, and click Next.

At the New Connector page, click New to create the connector.

Click Finish to close the New SMTP Send Connector wizard.

Configuring the Exchange Server 2010 Mailbox role

1.
2.
3.
4.

Select Start—>All Programs—> Microsoft Exchange Server 2010 Exchange Management Console.
In the left pane, expand Organization Configuration, and click Mailbox.

Click the Database Management tab.

Right-click Mailbox Database, and select Properties.
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Select the Maintenance tab.
Check the Enable circular logging box.

5
6
7. Check the box beside This database can be overwritten by a restore.
8. Next to Maintenance Schedule, click Customize.

9

. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

10. Click OK.

11. Click OK to any warnings about circular logging being applied after the database is remounted.

12. On the far right panel, click Move Database Path.

13. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Maillogs respectively,
and click Move.

14. If the application prompts you to dismount, click Yes.

15. Click Finish.

16. Right-click Public Folder Database, and select Properties.

17. Check the Enable circular logging checkbox

18. Click Customize next to Maintenance interval.

19. Remove all blue from the boxes so the system will not perform maintenance, and click OK.

20. Click OK.

21. On any warnings about circular logging being applied after the database is remounted, click OK.

22. Click Move Database Path on the far right panel.

23. Change the Database file and Log folder path locations to E:\Database\(filename) and F:\Publiclogs respectively,
and click Move.

24. If the application prompts you to dismount, click Yes.

25. Click Finish.

Configuring the database (DVD Store)
Data generation overview

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the
parameters for our 40GB database size and the database platform on which we ran: Microsoft SQL Server. We ran the
Install.pl script on a utility system running Linux. The database schema was also generated by the Install.pl script.

After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2012. We built the 40GB database in SQL Server 2012, and then performed a full
backup, storing the backup file on the C: drive for quick access. We used that backup file to restore to the servers
between test runs. We performed this procedure once.

The only modification we made to the schema creation scripts were the specified file sizes for our database. We
explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the
test. Besides this file size modification, the database schema was created and loaded according to the DVD Store
documentation. Specifically, we followed the steps below:

1. We generated the data and created the database and file structure using database creation scripts in the DS2
download. We made size modifications specific to our 40GB database and the appropriate changes to drive
letters.

2. We transferred the files from our Linux data generation system to a Windows system running SQL Server.

Remote office server performance: Dell PowerEdge R720 server with
Samsung solid-state drives and Windows Server 2012

A Principled Technologies test report 18



10.
11.
12.

We created database tables, stored procedures, and objects using the provided DVD Store scripts.

We set the database recovery model to bulk-logged to prevent excess logging.

We loaded the data we generated into the database. For data loading, we used the import wizard in SQL Server
Management Studio. Where necessary, we retained options from the original scripts, such as Enable Identity
Insert.

We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.

We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.

On the SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:

USE [master]

GO

CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
DEFAULT DATABASE=[master],
DEFAULT LANGUAGE= [us_english] ’
CHECK EXPIRATION=OFF,
CHECK POLICY=OFF

GO

We set the database recovery model back to full.

We created the necessary full text index using SQL Server Management Studio.

We created a database user and mapped this user to the SQL Server login.

We then performed a full backup of the database. This backup allowed us to restore the databases to a pristine
state relatively quickly between tests.

Running the DVD Store tests

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store

outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report

the last OPM result reported by each client/target pair.

Each complete test cycle consisted of the general steps listed below. For each scenario, we ran three test cycles,

and reported the median outcome.

1.

Nouvs~wN

Clean up prior outputs from the server and all client driver systems.

Drop all databases from the test servers.

Restore all databases on all test servers.

Reboot the server and all client systems.

Let the test server idle until the power utilization settled.

Start the DVD Store driver on all respective clients.

We used the following DVD Store parameters for testing the servers in this study:

ds2sglserverdriver.exe --target=<target IP> --ramp rate=10 -
warmup time=10 --run time=30 --n threads=30 --db size=40GB --
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think time=<appropriate think time for configuration> --detailed view=Y -

database name=DS2

Installing and configuring the Exchange 2010 mail test clients and completing LoadGen

configuration on the Exchange 2010 VM

For our testing, we used five virtual client machines to distribute the LoadGen workload evenly for each of the

solutions. To create the mail clients, we installed several software components. First, we made sure to statically assign

an IP address for each client. We followed this process for each installation:

Installing Windows Server 2008 R2 SP1 Enterprise Edition

W oo N R WNPRE
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Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

At the Language Selection Screen, click Next.

Click Install Now.

Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

Click the | accept the license terms checkbox, and click Next.

Click Custom.

Click Next.

At the User’s password must be changed before logging on warning screen, click OK.

Enter the desired password for the administrator in both fields, and click the arrow to continue.

. At the Your password has been changed screen, click OK.

. Click Start, type change power-saving settings and press Enter.

. Click Change plan settings.

. Change the Turn off the display drop-down menu to Never.

. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail

the necessary installation processes.

Joining the domain

1. Select Start->Control Panel>Network Connections—>Local Area Connection.

2. Click Properties.

3. Highlight Internet Protocol (TCP/IP), and click Properties.

4. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the
Preferred DNS server field. Click OK.

5. Right-click My Computer, and select Properties.

6. Under the Computer Name tab, click Change.

7. Inthe Computer Name Changes screen, under the Member of section, select the Domain radial box, and type
test.local

8. Select OK to start joining the domain.

9. When the screen appears asking for a person qualified on the domain, type Administrator as the username
and Passwordl as the password.
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10.

11.
12.

At the Welcome pop-up window and the window warning that you must reset the computer for the changes to
take effect, click OK.

At the System Properties screen, click OK.

When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services

=
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13.
14.

Click Start->Administrative Tools=>Server Manager.

On the left pane, click Roles.

Click Add Roles.

Click the Application Server checkbox.

When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next.

Click Next.

At the Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.
Click Add Required Support Role Services.

. Click Next.
. Click Next.
. At the Select Role Services page for Web Server (11S), click IIS 6 Management Compatibility, ASP, and CGl

checkboxes; and click Next.
Click Install.
Click Close.

Installing Load Generator

Download and install Load Generator using all defaults.

Preparing Load Generator

1. Loginto the mail client.

2. Select Start>All Programs—> Microsoft Exchange—> Exchange Load Generator 2010.

3. When the Load Generator screen appears, select Start a new test.

4. Select Create a new test configuration, and click Continue.

5. Change the total length of simulation to 1 hour and 15 minutes.

6. Inthe Specify test settings screen, type Passwordl as the Directory Access Password and Mailbox Account
Master Password, and click Continue with recipient management.

7. Make 250, or 500 users in the Mailbox Database, and click Continue.

8. To accept defaults for Advanced recipient settings, click Continue.

9. Inthe Specify test user groups screen, select the plus sign to add a user group.

10. Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_500, and the Mailbox size to 250
MB.

11. Check the PreTestLogon checkbox, and click Continue.

12. In Remote configurations, check the checkbox to enable distributing the workload, enter the computer names of
all of the test clients, and click Continue.

13. Click Save the configuration file as, and name it testcfg.xml

14. Open the configuration file in notepad.
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15.

16.
17.
18.
19.

20.

Search for FlowControlPoint and in that section, change "<Enabled>true</Enabled>" to
"<Enabled>false</Enabled>"

Search for MaximumThreadPoolThreads and change that from 80 to 16

Save and close the config file.

Close and restart LoadGen.

Open the saved (modified) configuration file in LoadGen and navigate through the screens until the summary
screen.

Check the Initialize public store as well checkbox, and click Start the initialization phase (recommended before
running the test).

Backing up the mail databases

On the Exchange server virtual machine, once we set up the LoadGen client and created its initial mail database,

we backed up the database so we can have clean copies for each test.

1.
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9.

10.

11.
12.

Select Start—=>All Programs—> Microsoft Exchange Server 2010 Exchange Management Console in the mail
server.

In the left pane, expand Organization Configuration and Mailbox.

In the right pane, right-click the Mailbox Database, and select Dismount Database from the menu.

At the Do you want to continue? pop-up message, click Yes.

Right-click Public Folder Database, and select Dismount Database from the menu.

At the Do you want to continue? pop-up message, click Yes. The red arrow appears when you have dismounted
the Public Folder Store.

Using Windows Explorer, create a new folder: E: \backup\

With Windows Explorer, copy all database and public folder files from E:\Database to E:\backup. This process
may take several minutes.

Close Windows Explorer.

In the Exchange Management Console, right-click each the Mailbox Database, and select Mount Database from
the menu.

Right-click the Public Folder Database, and select Mount Database from the menu.

Close the Exchange Management Console.

Preparing the SharePoint test client

Install Windows Server 2008 SP1 with current updates.

Installing Microsoft Visual Studio 2010 Ultimate Edition

1.

2.
3.
4

g

Download vs_ultimateweb.exe from www.microsoft.com/download/en/details.aspx?id=12752

Double-click vs_ultimateweb.exe to run the installer.

Uncheck the box beside Yes, send information about my computer, and click Next.

If you see a pop-up requiring a Windows Imaging component, click the Windows Imaging Component is
Required link.

Click Download on the appropriate Imaging component, and choose Run.

Accept the EULA, and click Next.

Close the pop-up window.
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8.
9.

10.
11.
12.
13.
14.

Click Next.

Accept the EULA, review the components to be installed, and click Next.

Choose the Full installation and location for the install, and click Install.

Click Finish.

Reboot the machine.

Click Start=>All Programs—>Microsoft Visual Studio 2010-> Microsoft Visual Studio 2010.
When prompted, select General Development Settings and click Start Visual Studio.

Setting up and running WSSDW 1.0.0.0 Beta

1.

/>

Complete the following steps on the Domain Controller machine:

a. InServer Manager, click Tools=> Active Directory Users and Computers.

b. Right-click the domain name and select New—>Group.

c. Enter testdomaingroupl forthe group name and click OK.

d. Repeat steps a through c and create another group named testdomaingroup?
Download the following from http://sptdatapop.codeplex.com/releases/view/1141

e To the SharePoint 2010 VM
o WSS Data Population Tool RunTime.zip
o WSS Data Population Tool.chm
o WSS Data Population Tool Sample.zip
e Tothe SharePoint 2010 test client
o WSS Performance Load Tests
Complete the following steps on the SharePoint 2010 VM:

a. Extract the contents of WSS Data Population Tool RunTime.zip and WSS Data Population Tool Sample.zip.

b. Copy the contents of both extracted .zip folders (WSS Data Population Tool Run Time and WSS Data
Population Tool Sample) into the root of C:

c. Download SharePtServerDeployment.doc from http://www.microsoft.com/en-
us/download/details.aspx?id=10009 and place it into the c:\wssdw folder.

d. Rename WSS Data Population Sample File.xmlto WSS Data Population Sample File.xml so that
there are no spaces in the name. This allows the script to execute from the command prompt.

e. Right-click WSS_Data_Population_Sample_File.xml and click Edit to open the document in Notepad. Scroll
down to line 55 and remove “.txt” from the document name in the destfile parameter. Then, change any
applicable parameters to match the following:

<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty
<setproperty

NumberOfSiteCollections="100" />
SiteNameBase="testsite" />

NumberOfGroups="2" />

GroupNameBase="testgroup" />
TargetDomain="test.local" />
DomainGroupRoot="testdomaingroup" />
DomainUserName="Administrator" />
DomainUserPassword="Passwordl" />
DesignerGroup="design" AdminGroup="full control" />
NumberOfDocumentLibraries="5" />
DocumentLibraryNameBasel="testdoclib A" />
NumberOfDocuments="5" />
SourceFilelLocation="c:\wssdw\SharePtServDeployment.doc"
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<setproperty DestFile="test.doc" />

<setproperty NumberOfFileVersions="3" />

<setproperty DocumentLibraryNameBase2="testdoclib B" />
<setproperty NumberOfLists="10" />

<setproperty ListNameBase="testlist" />

<setproperty NumberOfListItems="20" />

<setproperty webpartpath="webpartpagesfolder" />

f. Open the command prompt, and execute the following script:
C:\>WSSDW.exe WSS Data Population Sample File.xml

4. Complete the following steps on the SharePoint 2010 test client:
a. Extract the contents of WSS Performance Load Test to C: drive on the SharePoint test client.
b. On the SharePoint test client, open the WSSTransactions folder, right-click=> Edit, and modify the following
files as follows:
® users.csv
Under username, password enter test.localladministrator,Passwordl and
remove the remaining entries.
e serverUrl.csv
Under serverUrl replace http://server with http://spserver to match the server
name of the SharePoint 2010 VM.
e HierarchyManagerUsers.csv
Under username,password replace domain\username, password with
test.localladministrator, Passwordl

c. Open the WssTestProject.sIn file in Visual Studio 2010 Ultimate.

d. When prompted, click Next.

e. Click Finish.

f.  When prompted, leave the Retarget the project to .NET Framework 4. After the project opens, you can
retarget it to another Framework or Profile radio button selected, and click OK.

g. Click Close.

h. Inthe Solution Explorer pane, scroll to WSSDispForm, and double-click it.

i. Expand the top menu under WSSDispForm in the left pane, expand Validation rules, and delete the FindText
entry that references mysite.aspx.

j. Click Save.

k. Repeat steps h through j for WSSHomePage and WSSSmallDocLibAllltems.

I.  Click Project->Add Load Test.

m. At the Welcome to the Create New Load Test Wizard, click Next.

n. Enter Test for the load test scenario name, change the think time between test iterations to 30 or 15
seconds, and click Next.

0. Atthe Load pattern settings for a load test scenario screen, select Constant load, enter 125 for the User

Count, and click Next.
p. Click Next at the Select a test mix model for the load test.
g. Atthe Add test to a load test scenario and edit the test mix, click Add and select the following tests from the
list below. Additionally, modify the distribution as follows:
e WSSDispForm 10%
e WSSDocHTTPFetch 30%
e WSSHomePage 20%
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e WSSSmallDocLibAllltems 30%
o  WSSPutDocumentCoded 10%
Click Next.
At the Network types screen, select LAN, and click Next.
At the Browser screen, click Next.
At the Specify computers to monitor with counters sets during load test run screen, click Next.
At the Review and edit run settings for load test screen, enter 15 minutes for the Warm-up duration, enter
30 minutes for Run duration, and click Finish.
w. To ensure that the WSSDW workload evenly selects different SharePoint sites at random, create .csv lists of
a number of categories within each test and add the following parameters to each:
e WSSDispForm: Site name, list name, and list IDs.
e WSSDocHTTPFetch: Site name, doc revision, document library name, and document name.
o WSSHomePage: Site name
e WSSSmallDocLibAllltems: Site name, and document library name
e WSSPutDocumentCoded: Site name
X. Add the following lines of code to the WSSPutDocumentCoded test:

< c v >

[DeploymentItem ("officeservertransactions\\siteNames.csv",
"officeservertransactions") ]

[DataSource ("Sites", "Microsoft.VisualStudio.TestTools.DataSource.CSV",
"|DataDirectory|\\officeservertransactions\\siteNames.csv",
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingAccessMethod.Random,
Microsoft.VisualStudio.TestTools.WebTesting.DataBindingSelectColumns.SelectO
nlyBoundColumns, "siteNames#csv") ]

[DataBinding ("Sites", "siteNames#csv", "siteName",
"Sites.siteNames#csv.siteName") ]

At the "WebTestRequest request1" line, add:

+ this.Context["Sites.siteNames#csv.siteName"].ToString() +

Running the test

To run the test, we staggered the workload, allowing each benchmark time to warm up prior to measuring the
performance and latency on each of the solutions.

1. Begin running the LoadGen benchmark. LoadGen is set to run for 1 hour and 15 minutes, with a 15-minute
allotted warm-up period, 15-minute period for the other benchmarks to warm up, 30-minute time of recorded
latency, and 15-minute cool-down period.

2. Fifteen minutes after beginning the LoadGen benchmark, start the WSSDW workload. This workload is set to run
for 1 hour, with a 15-minute warm up period, 30-minute run period, and 15-minute cool-down period.

3. Five minutes after WSSDW begins, start the DVD Store benchmark. DVD Store is set to warm up for 10 minutes,
and then run for 30 minutes of recorded performance to coincide with LoadGen.

Remote office server performance: Dell PowerEdge R720 server with A Principled Technologies test report 25
Samsung solid-state drives and Windows Server 2012



ABOUT PRINCIPLED TECHNOLOGIES

= We provide industry-leading technology assessment and fact-based marketing
Principled .services. We bring to every assignment extens_ive experience V\{ith and expertise
Technologies® in all aspects of technology testing and analysis, from researching new
technologies, to developing new methodologies, to testing with existing and new
tools.

Principled Technologies, Inc.
1007 Slater Road, Suite 300
Durham, NC, 27703
www.principledtechnologies.com

When the assessment is complete, we know how to present the results to a
broad range of target audiences. We provide our clients with the materials they
need, from market-focused data to use in their own collateral to custom sales
aids, such as test reports, performance assessments, and white papers. Every
document reflects the results of our trusted independent analysis.

We provide customized services that focus on our clients’ individual
requirements. Whether the technology involves hardware, software, Web sites,
or services, we offer the experience, expertise, and tools to help our clients
assess how it will fare against its competition, its performance, its market
readiness, and its quality and reliability.

Our founders, Mark L. Van Name and Bill Catchings, have worked together in
technology assessment for over 20 years. As journalists, they published over a
thousand articles on a wide array of technology subjects. They created and led
the Ziff-Davis Benchmark Operation, which developed such industry-standard
benchmarks as Ziff Davis Media’s Winstone and WebBench. They founded and
led eTesting Labs, and after the acquisition of that company by Lionbridge
Technologies were the head and CTO of VeriTest.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Disclaimer of Warranties; Limitation of Liability:

PRINCIPLED TECHNOLOGIES, INC. HAS MADE REASONABLE EFFORTS TO ENSURE THE ACCURACY AND VALIDITY OF ITS TESTING, HOWEVER,
PRINCIPLED TECHNOLOGIES, INC. SPECIFICALLY DISCLAIMS ANY WARRANTY, EXPRESSED OR IMPLIED, RELATING TO THE TEST RESULTS AND
ANALYSIS, THEIR ACCURACY, COMPLETENESS OR QUALITY, INCLUDING ANY IMPLIED WARRANTY OF FITNESS FOR ANY PARTICULAR PURPOSE.
ALL PERSONS OR ENTITIES RELYING ON THE RESULTS OF ANY TESTING DO SO AT THEIR OWN RISK, AND AGREE THAT PRINCIPLED
TECHNOLOGIES, INC., ITS EMPLOYEES AND ITS SUBCONTRACTORS SHALL HAVE NO LIABILITY WHATSOEVER FROM ANY CLAIM OF LOSS OR
DAMAGE ON ACCOUNT OF ANY ALLEGED ERROR OR DEFECT IN ANY TESTING PROCEDURE OR RESULT.

IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES, INC. BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH ITS TESTING, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN NO EVENT SHALL PRINCIPLED TECHNOLOGIES,
INC.’S LIABILITY, INCLUDING FOR DIRECT DAMAGES, EXCEED THE AMOUNTS PAID IN CONNECTION WITH PRINCIPLED TECHNOLOGIES, INC.’S
TESTING. CUSTOMER’S SOLE AND EXCLUSIVE REMEDIES ARE AS SET FORTH HEREIN.
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